ZSSC30x6 Evaluation Kit Description

Contents
1  Introduction....................................................................................................................................................3
2  Evaluation Kit Overview ..............................................................................................................................3
  2.1  Installing the Software ..................................................................................................................................4
    2.1.1  Installing the USB Drivers ..................................................................................................................4
    2.1.2  Installing ZSSC30x6 Evaluation Software ..........................................................................................5
3  Evaluation Kit Hardware ...................................................................................................................................5
  3.1  Communication Board ..................................................................................................................................5
  3.2  Evaluation Board .........................................................................................................................................7
  3.3  IC Orientation for ZSSC3026/ZSSC3036 Adapter .........................................................................................8
  3.4  Interface Selection .......................................................................................................................................9
  3.5  Connectors .................................................................................................................................................10
  3.6  Supply Voltage ..........................................................................................................................................11
    3.6.1  Internal Supply Voltage .......................................................................................................................11
    3.6.2  External Supply Voltage .....................................................................................................................11
4  Evaluation Kit Software ..................................................................................................................................13
  4.1  Top Menu GUI Controls ...........................................................................................................................14
  4.2  Measurement Color Code ..........................................................................................................................15
  4.3  GUI Menu Bar ..........................................................................................................................................16
    4.3.1  Save/Load MTP Register Contents ....................................................................................................16
    4.3.2  Scan I2C™ Bus via the Scan I2C address Feature .............................................................................17
  4.4  GUI – General Tab ....................................................................................................................................17
  4.5  Data Logging ...........................................................................................................................................18
    4.5.1  Communication Log ............................................................................................................................18
  4.6  GUI – MTP Tab .........................................................................................................................................20
  4.7  GUI – EXT Tab ........................................................................................................................................20
    4.7.1  Get_Raw Commands ............................................................................................................................21
    4.7.2  Data Output Range ..............................................................................................................................22
    4.7.3  Setting up the Bridge Configuration for Calibration ...........................................................................24
  4.8  GUI – Calibration Tab ..............................................................................................................................26
    4.8.1  Calibration Input ....................................................................................................................................27
    4.8.2  Calibration Output ..................................................................................................................................28
    4.8.3  Calibration Process ..............................................................................................................................29
5  Sensor Replacement Board (SRB) ..................................................................................................................32
6  Related Documents and Files ........................................................................................................................33
7  Glossary .........................................................................................................................................................33
8  Document Revision History ..........................................................................................................................34
Appendix A: Schematics Communication Board ...........................................................................................35
Appendix B: Schematic Evaluation Board ........................................................................................................38

© 2019 Renesas Electronics Corporation

April 1, 2016
List of Figures

Figure 2.1 ZSSC30x6 Evaluation Kit Overview ................................................................. 4
Figure 3.1 Components on the Top of the ZSSC30x6 Communication Board .................. 6
Figure 3.2 Components on the Bottom of the ZSSC30x6 Communication Board .......... 7
Figure 3.3 ZSSC30x6 Evaluation Board ...................................................................... 8
Figure 3.4 Orientation of the PQFN in the PQFN Adapter ............................................. 8
Figure 3.5 Communication Interface Selection on CB and EB ...................................... 9
Figure 3.6 Connectors and the Pin Assignments at the CB .......................................... 10
Figure 3.7 Connectors and the Pin Assignments at EB ................................................ 10
Figure 3.8 Jumper Settings on Communication Board for Internal Supply Voltage ......... 11
Figure 3.9 Jumper Settings on Communication Board for External Supply Voltage ......... 12
Figure 4.1 GUI View after Opening the Evaluation Software ......................................... 13
Figure 4.2 Structure of the GUI Menu Bar – ZSSC3026 Example ................................. 16
Figure 4.3 I²C™ Communication Example .................................................................. 18
Figure 4.4 I²C™ Communication Structure for Example Communication Log ............... 19
Figure 4.5 SPI Communication Example .................................................................... 19
Figure 4.6 User-Accessible Memory, Addresses 00HEX through 17HEX ....................... 20
Figure 4.7 Tab for Externally Defined Communication .............................................. 21
Figure 4.8 External Bridge Measurement Configuration ............................................. 25
Figure 4.9 Calibration Tab Structure .......................................................................... 26
Figure 4.10 Calibration Point Definition ........................................................................ 28
Figure 4.11 Measuring a Calibration Data Point ........................................................... 30
Figure 4.12 Coefficient Calculation .............................................................................. 31
Figure 5.1 Sensor Replacement Board ........................................................................ 32
Figure 5.2 Resistance Network of the SRB ................................................................. 32

List of Tables

Table 4.1 Basic GUI Controls .................................................................................... 14
Table 4.2 Color Code for Bridge and Temperature Results .......................................... 15
Table 4.3 General Tab – Displays and Controls ......................................................... 17
Table 4.4 Get_Raw Commands .................................................................................. 22
Table 4.5 Data Output Ranges .................................................................................... 23
Table 4.6 Calibration Types ....................................................................................... 27
Table 4.7 Calibration Data Collection ......................................................................... 29
Table 4.8 Calculate and Write Coefficients ............................................................... 30
1 Introduction

This document describes the functionalities of the Evaluation Kits for the ZSSC3016, ZSSC3026, and ZSSC3036, referred to here as the ZSSC30x6 Evaluation Kit. Note: Most illustrations show the ZSSC3026, but the content applies to any ZSSC30x6 IC. This document covers the hardware components, the product specific configuration, the evaluation software, and its handling. The software is designed for Windows®-based operating systems to communicate with the ZSSC30x6 Evaluation Kit via the USB connection of the PC.

2 Evaluation Kit Overview

The ZSSC30x6 Evaluation Kit includes the following hardware components:

- ZSSC30x6 Communication Board (CB)
- ZSSC3016 Evaluation Board (EB)
  Note: The same ZSSC3016 EB is used for all three kits.
- Sensor Replacement Board (SRB)
- Ribbon cable for the connection between the boards (14 pin)
- ZSSC30x6 IC sample (DUT)
- USB cable for the connection to a PC

The ZSSC30x6 Evaluation Software and the documentation are available at:

- [www.IDT.com/ZSSC3016KIT](http://www.IDT.com/ZSSC3016KIT)
- [www.IDT.com/ZSSC3026KIT](http://www.IDT.com/ZSSC3026KIT)
- [www.IDT.com/ZSSC3036KIT](http://www.IDT.com/ZSSC3036KIT)

The kit must be connected to a master, which is typically a PC.

The Evaluation Board provides a connector for connecting a sensor replacement device or a solder connection for a soldering a sensor to 4 pads.

Schematics for the Communication Board are provided in Appendix A. Schematics for the Evaluation Board are in Appendix B.
The IC sample provided with the kit has the following package type depending on the product:

- ZSSC3016: CDIP 18 package
- ZSSC3026: PQFN 24 package inside an adapter, which will be plugged into the CDIP socket.
- ZSSC3036: PQFN 24 package inside an adapter, which will be plugged into the CDIP socket.

2.1. Installing the Software

The Evaluation Kit uses an FDTI controller on the Communication Board to handle the USB protocol, translate communications, and synchronize communications with the I²C™* and/or SPI interface.

2.1.1. Installing the USB Drivers

Before installing the ZSSC30x6 Evaluation Software, the USB drivers for the FTDI device must be installed. Download the drivers and corresponding installation guides from www.ftdichip.com/Drivers/D2XX.htm. The Evaluation Software accesses the FTDI controller through the D2XX DLL. The drivers will not affect the operation of any other USB peripherals. For installation of the drivers, the user’s system must meet these requirements:

- x86-compatible PC
- 64 MB RAM
- Hard drive with 20MB free space
- USB port
- Windows® 2000/XP/Vista/Windows® 7/Windows® 8

* I²C™ is a trademark of NXP.
2.1.2. Installing ZSSC30x6 Evaluation Software

To install the ZSSC30x6 Evaluation Software on the user’s PC hard drive after unzipping the downloaded ZSSC30x6 Evaluation Software zip file, navigate to the directory ZSSC30x6 EV SW_vXpxx (note: Xpxx refers to the latest version number). Double click on the setup.exe file and follow the resulting standard installation instructions, entering installation paths and identification as needed. The software automatically completes the installation and creates an access link under Start -> All Programs -> ZMDI -> ZSSC30x6 Evaluation if the defaults settings have been used.

3 Evaluation Kit Hardware

The delivered hardware consists primarily of two circuit boards: the ZSSC30x6 Communication Board and the ZSSC3016 Evaluation Board. They are connected via the 14-pin ribbon cable. The Communication Board has a USB interface for the connection to the master PC. The Evaluation Board has a CDIP 18 socket where the sample IC (a.k.a. the DUT) must be inserted. An adapter is used for ZSSC3026 and ZSSC3036 samples.

3.1. Communication Board

The ZSSC30x6 Communication Board has devices mounted on both sides. The components on the top side of the PCB generate a stable supply voltage and an optional external programming voltage. See Figure 3.1.

There is a pin header for using a jumper to select either the I^2C™ or SPI communication protocol for communication with the DUT in the socket on the Evaluation Board. The ribbon cable connector that connects the Communication Board to the Evaluation Board provides access to all communication signals; e.g., for an oscilloscope probe.

A metal potentiometer can be used to adjust the supply voltage in the typical range from 1.7V to 3.8V. Its initial adjustment on delivery provides a voltage VDD \approx 2.0V to 2.2V. The intensity of the adjacent LED is proportional to the supply voltage.
Figure 3.1 Components on the Top of the ZSSC30x6 Communication Board

- Potentiometer for adjusting VDD voltage
- Select target voltage (internal / external) (K5)
- Switchable pull-up resistor (K11)
- Set for transistor level-shifter (K9)
- SDA mode selection (K7)
- I2C/SPI selection (K10)
- USB power indication LED
- USB B-type connector
- IC power indication LED
- Full featured 14-pin connector (K4)
- Indication LED for Vpp Voltage
- External voltage
- Switchable pull-up resistor (K11)
- Set for transistor level-shifter (K9)
- SDA mode selection (K7)
- I2C/SPI selection (K10)
On the bottom side of the Communication Board, the largest IC is the FTDI microcontroller for protocol handling. There are also voltage regulators for the two variable voltages (VDD and VPP) and level shifters for communication signals.

**Figure 3.2 Components on the Bottom of the ZSC30x6 Communication Board**

3.2. **Evaluation Board**

The ZSSC30x6 Evaluation Board allows the user to use an oscilloscope to analyze all available signals to and from the DUT and to select the communication interface for it via a jumper, which must match the setting on the Communication Board. The Evaluation Board provides two alternatives for connecting a sensor or a sensor replacement device: via a 16-pin square sensor connection terminal or by soldering a sensor with 4 pads on it to an SMD footprint (see Figure 3.3).

The K1 and K2 pin header blocks (4 pins x 9 pins) adjacent to the DUT socket allow using a 2-pin jumper to connect signal lines of the DUT (either of the 2 middle pins in each row of each header block) to either VSS (the GND trace pin adjacent to the DUT) or VDD (the outer V_TGT trace pin, which is the supply voltage generated from the Communication Board).

To connect the proper supply required for the DUT, use the red jumper to connect the DUT’s VDD signal line to the V_TGT line as shown in Figure 3.3. Use the black jumper to connect the DUT’s VSS pin to the GND line.
3.3. IC Orientation for ZSSC3026/ZSSC3036 Adapter

Figure 3.4 demonstrates the orientation for the ZSSC3026 or ZSSC3036 in the PQFN package adapter required for proper function on the Evaluation Board.

**Note:** The jumpers for the VDD and/or VSS connection might be missing on the delivered ZSSC30x6 Evaluation Board. In this case, please insert the jumpers on the board as shown in Figure 3.5. They are mandatory for the power supply for the IC sample.
3.4. Interface Selection

Jumpers on the Communication Board must be set as shown in Figure 3.5. Further details for the signal path can be found in the schematics in Appendix A.

The blue jumper on the Evaluation Board defines the protocol for the DUT in the following way:

- Jumper on the “I2C” position $\rightarrow$ SEL = HIGH
  
  For the I$^2$C™ selection, the jumper does not need to be connected. In this case, the SEL input to the DUT is recognized as HIGH.

- Jumper on the “SPI” position $\rightarrow$ SEL = LOW
  
  For SPI, the interface jumper is required to pull the SEL signal to the LOW level.

**Figure 3.5 Communication Interface Selection on CB and EB**

Note: Interface settings on the CB and EB must match.
3.5. Connectors

The connectors on the CB and EB are labeled. The kit must be assembled by the customer. When the ribbon cable is connected correctly, it provides all possible signals between the microcontroller on the CB and the DUT on the EB. The minimum signals required are VDD, VSS, SDA, and SCL; these lines can provide all options for measurements and I²C™ communication.

Figure 3.6 shows the pin assignment for the available connectors at the CB.

*Figure 3.6 Connectors and the Pin Assignments at the CB*

![Connectors and the Pin Assignments at the CB](image)

*Figure 3.7 Connectors and the Pin Assignments at EB*

![Connectors and the Pin Assignments at EB](image)

Note: The signal names on the CB and EB do not match for some signals due to different origins for the boards; nevertheless the actual signals are provided at the same pins at the corresponding connectors.
3.6. Supply Voltage

The Evaluation Kit can be powered with an internal or external voltage supply for the DUT on the Evaluation Board, which must be selected with the red jumper on the K5 pin header on the CB (see Figure 3.1). There are no settings for selecting the supply source on the EB.

3.6.1. Internal Supply Voltage

The internal VDD supply is generated by a regulator circuit on the CB. It is used as the HIGH level reference for all signals that are necessary for communication with the DUT. If the red jumper on K5 is positioned as shown in Figure 3.8 ("int" setting), then the DUT on the EB is supplied internally. With this setting, no external voltage input is needed for the Evaluation Kit.

3.6.2. External Supply Voltage

An alternative for providing the supply voltage to the DUT is to input an external voltage supply source. Ensure that the external voltage does not exceed the voltage supply specifications given in the IDT data sheet for the DUT before connecting to the Evaluation Kit.

To use an external supply, set the K5 jumper as shown in Figure 3.9 ("ext" setting). Connect the external voltage to the 2-pin V_ext header that is immediately to the right of the K5 jumper with the orientation shown in Figure 3.9. There are no adjustments for the external voltage on either the CB or EB.
Figure 3.9  Jumper Settings on Communication Board for External Supply Voltage
4 Evaluation Kit Software

When the ZSSC30x6 Evaluation Software (GUI) is activated, the left side of the first screen is the General tab, which provides basic communication status (see Figure 4.1). The largest section of the screen is the main graph area on the right, which is for displaying the measurement results over time. The data scale for temperature output is on the right side of the main graph; the scale for bridge measurements is on the left. The x-axis represents the number of measurement points at a given value in a run. Both y-axes display the corresponding bridge/temperature value in a format selectable by the user.

Figure 4.1 GUI View after Opening the Evaluation Software
4.1. Top Menu GUI Controls

At the top of the GUI screen is a banner for GUI controls that are always available. These include display fields at the left for real-time single bridge and temperature measurement results. There are also additional controls with the following descriptions and functions:

<table>
<thead>
<tr>
<th>Table 4.1 Basic GUI Controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control</td>
</tr>
<tr>
<td>-------------------------</td>
</tr>
<tr>
<td><strong>Port button</strong></td>
</tr>
<tr>
<td><strong>Status display field</strong></td>
</tr>
<tr>
<td><strong>Power On/Off icon</strong></td>
</tr>
<tr>
<td><strong>average values checkbox</strong></td>
</tr>
<tr>
<td><strong>Bridge graph/ Temp. graph slider bars</strong></td>
</tr>
<tr>
<td><strong>log communication checkbox</strong></td>
</tr>
</tbody>
</table>
Control | Description
--- | ---
Start | This button activates a cyclic bridge and/or temperature measurement. The measurement mode is defined by the *Raw / DSP Corrected* measurement mode slider bar to the left of this button.

**Measurement Mode Slider**

Raw measurements must be configured either via the *External Configuration* section under the *EXT tab* (see section 4.7), which is the recommended method, or by directly writing a configuration into the *BM_Config* register. The raw data output provides the results directly after AD conversion. The *DSP Corrected* position of the slider selects the configuration from the *BM_Config* register for the measurement. The digital result after the ADC will be then processed with the calculated coefficients. This measurement mode will provide valid results only after a valid calibration of the ZSSC30x6.

**Conversion Time**

This field indicates the period that is needed to complete a measurement command. This period is defined by the conversion time of the ADC, the IC processing time, and communication time between master and slave. Depending on the MSB/LSB segmentation settings, the conversion time can vary significantly. The default value of 200ms suffices to establish an auto-zero-corrected measurement with a MSB/LSB segmentation of 14/2. The conversion time can be derived from the ADC conversion times specifications given in the ZSSC30x6 Data Sheet.

**Status ?**

This button requests and reads the ZSSC30x6’s status byte and displays the result on the LEDs on the *General* tab.

**Read MTP (all)**

Reads the complete contents of the multiple-time programmable (MTP) memory of the ZSSC30x6. The decoded basic bridge configuration and the I²C™ address are displayed on the *General* tab.

**Write MTP (sel)**

This button activates writing to the MTP of the ZSSC30x6. It will write only the addresses for which the content is shown in red font on the *MTP* tab. In addition to using the automatic data transfer from the *Calibration* tab and *General* tab, users can also edit the values by double clicking on the value on the *MTP* tab page. The ZSSC30x6 must be in Command Mode (CM) in order to write to the MTP; therefore the software performs a power-on >power-off >Start CM sequence in the background. After the write operation, the ZSSC30x6 will be set into Normal Mode again.

4.2. **Measurement Color Code**

Bridge and temperature results are displayed in different colors. Different colors are also used for single and averaged measurement results:

<table>
<thead>
<tr>
<th>Color</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pink</td>
<td>Single bridge measurement.</td>
</tr>
<tr>
<td>Light Blue</td>
<td>Single temperature measurement.</td>
</tr>
<tr>
<td>Blue</td>
<td>Averaged bridge measurement.</td>
</tr>
<tr>
<td>Green</td>
<td>Averaged temperature measurement.</td>
</tr>
<tr>
<td>Red</td>
<td>Invalid measurement result. For a <em>Conversion Time</em> that is too short. In this case, bit 5 in the status byte is set to ‘1’ and the <em>Busy</em> virtual LED on the <em>General</em> tab turns on. Another reason for an invalid measurement result could be if ALU saturation is detected. In this case the <em>Saturation</em> LED turns on.</td>
</tr>
</tbody>
</table>
4.3. GUI Menu Bar

Figure 4.2 shows the submenu items that are accessible under the menu bar of the GUI.

The **File** menu allows selecting options to load or save the MTP configuration and options for logging measurement data and communication data.

4.3.1. Save/Load MTP Register Contents

Initially the customer memory pages are empty. If an identical memory configuration is needed for multiple ICs, it is possible to save a given setup as a template. When the required MTP content is present in the **MTP** tab, select **File > Save MTP Config**. The configuration file is created with an `.eep` extension, and it contains one decimal value for each MTP address in each row.

To load a configuration file, select **File > Load MTP Config**. Note: The decimal values will be automatically displayed as hexadecimal values in the **MTP** tab. The loaded data is displayed in red font in the **MTP** tab and can be written into the memory.
4.3.2. Scan I²C™ Bus via the Scan I2C address Feature

Another feature provided in the menu bar is the ability to scan the I²C™ bus to determine the I²C™ address of the ZSSC30x6. Selecting Scan I2C address triggers the scan during which the ZSSC30x6 status is requested for each address ranging from 00_HEX to 7F_HEX. When an I²C™ address is acknowledged by the ZSSC30x6, the scan stops, and this address is used for further communication during the current GUI session. The results of the scan are indicated in the status window:

- Status window message for a successful I²C™ scan: Valid I2C address found: 0xXX!
- Status window message for an I²C™ scan without slave acknowledge: No valid I2C address found!

The I²C™ address information is lost if the GUI or the communication port is closed. The communication to the ZSSC30x6 with an I²C™ address other than 00_HEX can also be established by typing it manually in the menu bar item interface setup by selecting Interface Setup > I2C Slave Address.

4.4. GUI – General Tab

Table 4.3 General Tab –Displays and Controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I2C Slave ADR</td>
<td>After reading the MTP, the display shows the I²C™ address that is saved in the memory. If a new address is entered in the window and the Copy adjusted settings to MTP button is clicked, the new value is shown in red color on the MTP tab.</td>
</tr>
<tr>
<td>Basic Bridge Configuration</td>
<td>The bridge configuration area provides settings of the analog signal path and AD conversion. The drop-down menus contain the available setting values. Changing the parameter values here does not automatically apply them to measurements. It is possible to apply the adjusted settings and use them for raw data collection. There are different commands for performing raw measurements. Some of the commands use the configuration from the BM_Config register (A0_HEX, A2_HEX); others (A1_HEX, A3_HEX) are configured via the interface. For a full description of raw measurement commands, refer to Table 4.4. For configuration via the interface, click on the Copy adjusted settings for Raw Data Acquisition button, which automatically displays the EXT tab (see section 4.7) and transfers the present settings to the external configuration section. The Copy adjusted settings to MTP button copies the present settings to the MTP tab. The settings can then be written to the MTP memory (see section 4.6).</td>
</tr>
<tr>
<td>IC Communication Status</td>
<td>The communication status section evaluates the status byte information sent from the sample. It provides following information via the virtual LEDs: Powered indicates if the device is powered. If the LED is off, it does not automatically mean that VDD is not supplied. For example, the LED will be off if the I²C™ communication is attempted with an I²C™ address different from the address programmed in the IC’s memory. CMD Mode shows whether the IC is in Command Mode. Test Mode shows whether the IC is in Test Mode (not intended for users) Busy indicates if processing of the last command is finished. If it is, the LED is off. Memory Error displays whether the checksum-based integrity check passed or failed. In the default state of the kit, this LED should be on. Recommended approach: after writing memory data (bridge configuration, coefficients…), write the signature over the memory content via the MTP Write Completion (Checksum) button on the MTP tab. After a subsequent power-on-reset sequence, the integrity check should pass and the LED should turn off. Saturation: This LED is on if the DSP core saturates; e.g., if the internal signal correction result exceeds the limits of the internal arithmetic unit.</td>
</tr>
</tbody>
</table>
4.5. Data Logging

The ZSSC30x6 Evaluation Kit software provides the option to log measurement and communication data as described in Table 4.1.

4.5.1. Communication Log

Communication with the IC can be logged for both the I2C™ and SPI interface. Use the log communication checkbox on the General tab for recording the data stream. Choose a path for which the user has writing permission for storing the log file. Open the log file via the menu bar: File -> Communication Log. The resulting text file is an ASCII file and can be imported into Microsoft® Excel.

4.5.1.1. I2C™ log

Figure 4.3 shows a short example of the I2C™ communication recorded in a log file.

![Figure 4.3 I2C™ Communication Example](image)

The log file maps only the transferred data, not the specific frame conditions for I2C™, such as START or STOP conditions or acknowledges. Communication commands that are not available to the user are not logged. This also applies to the SPI communication log.

The Evaluation Kit uses DF 5 (data fetch 5) by default. This means READ data from the slave has a 5-byte structure. In the example shown in Figure 4.3, a raw bridge measurement is done in two steps:

- Start Command Mode (A9HEX). After this command, it is not necessary to read; however, the Evaluation Kit software sends a command to read the status byte to obtain the most current status of the IC. In the second and fourth rows of the example above, the status byte of 4c is returned in the response to the master sending the slave address with the read/write bit (R/W) set to read.
- Get_Raw auto-zero corrected bridge data (A3HEX).

I2C™ interface properties correspond to the NXP I2C™ bus specification. For the I2C™ log example data, the sections of the data frame structure are explained in Figure 4.4. In this illustration for communication frames, START conditions are indicated with S; STOP conditions are shown as P; and acknowledges are shown with A. For information about communication frame structure, see the data sheet (see section 6).
4.5.1.2. SPI Log

Communication via SPI is accomplished with the single pins for input and output (MOSI and MISO respectively). The MOSI data always consists of 3 bytes; MISO data is always 5 bytes.

The example shown in Figure 4.5 has the same command sequence as the \( \text{I}^2\text{C} \)
example. The difference is the F0HEX command, which is sent in the Evaluation Kit each time before reading the MISO signal. This is due to IDT’s hardware/software setup for the kit. It is not required for the final user application.
4.5.1.3. Measurement Log

Measurement data can be recorded as well. In raw measurement mode, the results are logged in counts, but they are not calculated as percentage (bridge) or degree Celsius (temperature). If the IC is calibrated, the DSP-corrected bridge results are provided in counts and percentage based on the output range. The temperature results are logged in counts and degree Celsius numbers.

4.6. GUI – MTP Tab

The MTP tab shows the current memory data of the user’s page. The data is displayed in four hexadecimal digits for each of the 24 addresses in the MTP. To display the memory contents in the MTP table, read the complete memory by clicking on the Read MTP (all) button. The resulting message in the status window at the top right of the GUI should be “MTP Read OK.” Subsequent changes in this table are indicated with red font so that the user is aware that this data does not correspond with the IC’s data.

As shown in Figure 4.6, the first column is the address number; the second column comprises the data in the register. The description name for the corresponding register is given in the third column. The forth column is a single digit, which indicates whether an internal data correction has been asserted. Each 16-bit register displayed is also written to a redundant register. With each reading process, the origin and the redundant register are compared bitwise. If they do not agree, the correction bit in the fourth column will be set.

Figure 4.6 User-Accessible Memory, Addresses 00HEX through 17HEX
Clicking the *MTP Write Completion (Checksum)* button at the bottom of the *MTP* tab triggers the signature generation and writing over the current memory contents. Therefore it should be the last step to be done after bridge measurement configuration, coefficient calculation, and writing. Once the checksum has been written, the *Memory Error* LED turns off after repowering the IC (see Table 4.3).

Additional features on the *MTP* tab are the user memory page number and the *INC CUST Page* button for increasing the memory page. Each IC provides four customer pages; therefore it is possible to increase the CUST Page index three times.

For the *MTP write*(sel), *MTP Write Completion (Checksum)*, and *INC CUST Page* buttons, the IC must be in Command Mode, so the Command Mode is accessed and then exited by the software in the background.

### 4.7. GUI – EXT Tab

The *EXT* tab is divided into two sections. The upper tab area is for communication with the IC with single commands selectable from the drop-down menu. This section is considered as an additional communication option but it is not necessary for typical user purposes. The lower part of this tab is relevant for the external bridge configuration and temperature. “External” in this context means that the configuration does not have to be written to the memory. It can be transmitted with the measurement command over the communication interface. All commands defined in the *EXTERNAL CONFIGURATION* section are *Get_Raw* measurement requests.

**Figure 4.7 Tab for Externally Defined Communication**
In the “Bridge” and “Temperature” sections, the *Type* window defines the *Get_Raw* command and the *Data* window selects the measurement configuration if required.

Example: In the “Bridge” section, an entry of 0x3 in the *Type* field and 0x024A in the *Data* field corresponds to the *GetRaw* command 0xA3 024A.

### 4.7.1. *Get_Raw* Commands

Eight *Get_Raw* commands for data acquisition are available, depending on the measurement type and the source of the configuration; however, there are basically only two different commands: the single measurement and the auto-zero measurement, which selects the ADC offset. These are applied to the bridge and temperature measurements with different configuration origins.

All measurement command options are described in the Table 4.4.

**Table 4.4  *Get_Raw* Commands**

<table>
<thead>
<tr>
<th>Command</th>
<th>Measurement</th>
<th>AFE Configuration Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>A0_{HEX} + 0000_{HEX}</td>
<td>BM – Bridge Measurement</td>
<td><em>BM_Config</em></td>
</tr>
<tr>
<td>A1_{HEX} + ssss_{HEX}</td>
<td>BM – Bridge Measurement</td>
<td>ssss is the user’s configuration setting for the measurement provided via the interface. The format and purpose of configuration bits must be consistent with the definitions given in the <em>BM_Config</em> register.</td>
</tr>
<tr>
<td>A2_{HEX} + 0000_{HEX}</td>
<td>BM-AZBM – Auto-Zero corrected Bridge Measurement</td>
<td><em>BM_Config</em></td>
</tr>
<tr>
<td>A3_{HEX} + ssss_{HEX}</td>
<td>BM-AZBM – Auto-Zero corrected Bridge Measurement</td>
<td>ssss is the user’s configuration setting for the measurement provided via the interface. The format and purpose of configuration bits must be equal to the definitions for <em>BM_Config</em>.</td>
</tr>
<tr>
<td>A4_{HEX} + 0000_{HEX}</td>
<td>TM – Temperature Measurement</td>
<td>IDT-defined register.</td>
</tr>
<tr>
<td>A5_{HEX} + ssss_{HEX}</td>
<td>TM – Temperature Measurement</td>
<td>ssss is the user’s configuration setting for the measurement provided via the interface. The format and purpose of configuration bits must be consistent with the definitions given in the <em>BM_Config</em> register for temperature measurements (bits [15:13] will be ignored).</td>
</tr>
<tr>
<td>A6_{HEX} + 0000_{HEX}</td>
<td>TM-AZTM – Auto-Zero corrected Temperature Measurement</td>
<td>IDT-defined register.</td>
</tr>
<tr>
<td>A7_{HEX} + ssss_{HEX}</td>
<td>TM-AZTM – Auto-Zero corrected Temperature Measurement</td>
<td>ssss is the user’s configuration setting for the measurement provided via the interface. The format and purpose of configuration bits must be consistent with the definitions given in the <em>BM_Config</em> register for temperature measurements (bits [15:13] will be ignored).</td>
</tr>
</tbody>
</table>
4.7.2. Data Output Range

Raw measurement results display AD-converted data, without passing through the digital signal processor (DSP). Here, the ADC offset adjustment and the measurement methods determine the raw data output range. The expected output range is dynamically shown in the GUI, below the configured parameter of the EXT tab.

Output data in Normal Mode is digitally compensated and adjusted to the full-scale output of 16 bits if the device has been calibrated correctly.

Table 4.5 Data Output Ranges

<table>
<thead>
<tr>
<th>Raw Modes</th>
<th>Input Range</th>
<th>ADC Offset</th>
<th>Data Output</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Min</td>
</tr>
<tr>
<td>BM – Bridge Measurement</td>
<td>-1/16 to 15/16</td>
<td>1/16</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-8/16 to 8/16</td>
<td>8/16</td>
<td>0</td>
</tr>
<tr>
<td>AZBM – Auto-Zero Bridge Measurement</td>
<td>-1/16 to 15/16</td>
<td>1/16</td>
<td>-4096</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-8/16 to 8/16</td>
<td>8/16</td>
<td>-32768</td>
</tr>
<tr>
<td>TM – Temperature Measurement</td>
<td>-1/16 to 15/16</td>
<td>1/16</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-8/16 to 8/16</td>
<td>8/16</td>
<td>0</td>
</tr>
<tr>
<td>AZTM – Auto-Zero Temperature Measurement</td>
<td>-1/16 to 15/16</td>
<td>1/16</td>
<td>-4096</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-8/16 to 8/16</td>
<td>8/16</td>
<td>-32768</td>
</tr>
<tr>
<td>Normal Mode</td>
<td>-1/16 to 15/16</td>
<td>1/16</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-8/16 to 8/16</td>
<td>8/16</td>
<td>0</td>
</tr>
</tbody>
</table>
4.7.3. Setting up the Bridge Configuration for Calibration

If the sensor characteristics are known, the bridge measurement settings can be defined in the General tab. These parameters are:

- **Bridge Gain**: The analog gain is realized in two different amplifier stages. The possible gain factors of these two stages are selectable in the drop-down menu. Recommendation: Choose the bridge gain as high as possible in order to take full advantage of the ADCs’ dynamic range.

- **Bridge Polarity**: The IC has the capability to switch the polarity of the sensor input INP and INN. This setting is only valid if the differential sensor signal has a higher negative voltage output range than the positive one:

  - if \( |V_{\text{max}}| < |V_{\text{min}}| \) \( \Rightarrow \) Bridge Polarity = 1
  - else Bridge Polarity = 0

- **Bridge ADC segmentation**: A second-order charge-balancing analog-to-digital converter (ADC) is used to convert the amplifier signal. To allow optimizing the trade-off between conversion time and resolution, the conversion is split into a MSB coarse conversion and an LSB fine conversion.

- **Bridge Range Shift**: Depending on the sensor output, the ADC can be adjusted by a programmable offset from 1/16 to 8/16 of ADC’s reference voltage.

The most appropriate gain (and offset) setup for a specific sensor element can be determined by using the following steps:

1) Collect the sensor element’s characteristic, statistical data (over temperature, ambient sensor parameters, and production tolerances):
   - a. Minimum differential output voltage: \( V_{\text{min}} \)
   - b. Maximum differential output voltage: \( V_{\text{max}} \)

2) If \( V_{\text{min}} \) and \( V_{\text{max}} \) have different signs (normally: \( V_{\text{max}} \) is positive and \( V_{\text{min}} \) is negative), then the required ADC offset shift can be selected using the ratio: \( \text{RatioOffset} = \frac{|V_{\text{min}}|}{(V_{\text{max}} - V_{\text{min}})} \)

   Then, the respective offset setup (A2D_offset) is the nearest integer of multiples of 1/16 in the range of 1/16 to 8/16 (refer to the data sheet; see section 6): \( \text{A2D}_{\text{offset}} = \text{Round\_to\_x16th}\{\text{RatioOffset}\} \).

3) Determine which of the two following cases is valid, with \( V_{\text{ref}} = V_{\text{refp}} - V_{\text{refn}} = 0.94 \cdot V_{\text{DDB,min}} \approx 1.5V \):
   - a. If \( \text{RatioOffset} - \text{A2D}_{\text{offset}} \leq 0 \) then calculate the theoretical optimum gain:
     \[ \text{Gain}_{\text{opt}} = (1 - \text{A2D}_{\text{offset}}) \cdot \frac{V_{\text{ref}}}{V_{\text{max}}} \]
   - b. If \( \text{RatioOffset} - \text{A2D}_{\text{offset}} > 0 \) then calculate the theoretical optimum gain:
     \[ \text{Gain}_{\text{opt}} = \text{A2D}_{\text{offset}} \cdot \frac{V_{\text{ref}}}{|V_{\text{min}}|} \]

4) Select the setup gain (Gain_{setup}) as the nearest gain to Gain_{opt} where Gain_{setup} \( \leq \) Gain_{opt}. 
After setting up the bridge measurement configuration in the General tab, it can be assigned to the EXT tab via the Copy adjusted settings for Raw Data Acquisition button. The bridge settings appear now coded as a hexadecimal 16-bit number in the Data window of the “Bridge” section (see Figure 4.8). The configuration entered here is valid for further calibration processes.

Figure 4.8 External Bridge Measurement Configuration
4.8. GUI – Calibration Tab

The primary purpose of the Calibration tab is the overview of the calibration data and the resulting coefficients. This tab is divided in two sections: the input and the output of the calibration process (see Figure 4.9).

Figure 4.9 Calibration Tab Structure
4.8.1. Calibration Input

The data input section is located in the lower left of the Calibration tab. In this table, data points are defined with their reference information for bridge and temperature and the corresponding measurement results. Above the calibration point table, the calibration type can be selected in a drop-down menu. Available calibration types are described in Table 4.6.

<table>
<thead>
<tr>
<th>Type</th>
<th>Calculated Coefficients</th>
<th>Number of Data Points Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Point</td>
<td>OFFSET_B, GAIN_B</td>
<td>Bridge: 2, Temp: 0</td>
</tr>
<tr>
<td>3 Point</td>
<td>OFFSET_B, GAIN_B, SOT_B</td>
<td>Bridge: 3, Temp: 0</td>
</tr>
<tr>
<td>3 Point</td>
<td>OFFSET_T, GAIN_T, SOT_T</td>
<td>Bridge: 0, Temp: 3</td>
</tr>
<tr>
<td>4 Point</td>
<td>OFFSET_B, GAIN_B, TCO, TCG, OFFSET_T, GAIN_T</td>
<td>Bridge: 2, Temp: 2</td>
</tr>
<tr>
<td>5 Point</td>
<td>OFFSET_B, GAIN_B, TCO, OFFSET_T, GAIN_T, SOT_TCO, SOT_B, SOT_T</td>
<td>Bridge: 3, Temp: 3</td>
</tr>
<tr>
<td>6 Point</td>
<td>OFFSET_B, GAIN_B, TCO, TCG, OFFSET_T, GAIN_T, SOT_TCO, SOT_TCG, SOT_T</td>
<td>Bridge: 2, Temp: 3</td>
</tr>
<tr>
<td>7 Point</td>
<td>OFFSET_B, GAIN_B, TCO, TCG, OFFSET_T, GAIN_T, SOT_TCO, SOT_TCG, SOT_T, SOT_B</td>
<td>Bridge: 3, Temp: 3</td>
</tr>
</tbody>
</table>

Depending on calibration type, the corresponding number of calibration points are displayed in the main graph to indicate the coverage of the measurement range. The “Calibration Points” table contains the relevant points for coefficient calculation.

Entry descriptions for the calibration table:

P[%] – P stands for the bridge sensor measurement. The point should be entered as a percent of the full measurement range for the bridge sensor measurement.

P[N] – Raw bridge measurement result in counts.

T[°C] – Temperature in degree Celsius.

T[N] – Raw temperature measurement result in counts.

Example: If the final application is specified from 800 to 1200 mbar, then 5% is 820 mbar and 95% is 1180. Assuming the temperature range is from –40 to 80 degree Celsius, the initial calibration table for a 7-point calibration could be defined as it is shown in Figure 4.10.

Note: The definition of the temperature range in the calibration must be entered at the bottom of the Calibration tab. The degree Celsius entries in the “Calibration Points” table must match the range definition.
4.8.2. Calibration Output

The upper left section in the Calibration tab is the coefficient table, where the coefficients are displayed after calculation. If one of the coefficients exceeds the range limit, its value appears as a red number. In this case, the status window displays “Coefficients Range ERROR!”
4.8.3. Calibration Process

The following process for data collection describes one measurement point acquisition, representative for all calibration points. A detailed description for the calibration flow can be found in the document ZSSC30x6 Application Note – Calibration Sequence and DLL (see section 6).

Table 4.7 Calibration Data Collection

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Connect the Evaluation Board to a PC and make all necessary connections from the Evaluation Board to the ZSSC30x6 IC.</td>
<td>General tab</td>
</tr>
<tr>
<td>2</td>
<td>Start the Evaluation Software.</td>
<td>Calibration tab</td>
</tr>
<tr>
<td>3</td>
<td>Create a calibration setup for the user's system that is consistent with the sensor's characteristics. Click the Copy adjusted settings for Raw Data Acquisition button to enter the current configuration in the EXT tab as described in Figure 4.8. Alternatively, a pre-defined default setup can be loaded (see section 4.3.1).</td>
<td>EXT tab</td>
</tr>
<tr>
<td>4</td>
<td>Ensure that the default and recommended measurement types (command) for data acquisition are selected: Bridge: GetRaw Type: 3 Temperature: GetRaw Type: 6</td>
<td>EXT tab</td>
</tr>
<tr>
<td>5</td>
<td>Choose the calibration type via the Type drop-down menu.</td>
<td>Calibration tab</td>
</tr>
<tr>
<td>6</td>
<td>Set up the desired bridge sensor and temperature conditions so that the measurement can be performed in a stable state. Enter the reference conditions ( P% ) and ( T^{\circ} C ) in the corresponding rows in the Calibration Points table.</td>
<td>Calibration tab</td>
</tr>
<tr>
<td>7</td>
<td>Select the row where the present measurement data should be entered by clicking one of the row numbers from 1 to 7. Click on the Get Point ( P[N] ), ( T[N] ) button to trigger a single measurement. The measurement results will be automatically displayed the table (see Figure 4.11).</td>
<td>Calibration tab</td>
</tr>
<tr>
<td>8</td>
<td>The data for the remaining calibration points must be filled in the table by repeating the steps 6 and 7 for each point.</td>
<td>Calibration tab</td>
</tr>
</tbody>
</table>
After the calibration point acquisition is completed, the coefficients calculation can be performed. Completion of the calibration process is described in the following steps. Figure 4.12 illustrates these steps with blue arrows.

**Table 4.8 Calculate and Write Coefficients**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Calculate the coefficients via the Calculate Coefficients button. The coefficients will be displayed in the “Calculation Coefficients” table.</td>
<td>Calibration tab</td>
</tr>
<tr>
<td>2</td>
<td>Transfer the new coefficients to the MTP table by clicking on the Put Coefficients button. The values are concurrently selected for writing (turning red).</td>
<td>Calibration tab</td>
</tr>
<tr>
<td>3</td>
<td>For DSP-corrected bridge measurement, the BM_Config register must contain the same configuration as during calibration, so click on the Copy adjusted setting to MTP button. The coded configuration appears red-colored in BM_Config.</td>
<td>General tab</td>
</tr>
<tr>
<td>4</td>
<td>Write the new coefficients into the MTP via the Write MTP(sel). Read the MTP contents to ensure that the coefficients have been written to the memory.</td>
<td>MTP tab</td>
</tr>
</tbody>
</table>
## Step 5

The final step after a successful calibration and coefficients writing is to generate and write the checksum over the user memory. The **MTP Write Completion (Checksum)** button triggers the IC internal calculation of the checksum and writes it in the **Signature Cust** register.

### Location

**MTP tab**

## Step 6

Finished! After the next reset of the IC, the new coefficients will be used to calculate the output values if the measurement mode slider is switched to the **DSP Corrected** position. In the **General** tab the **Memory Error** LED is off.

### Location

**MTP tab**

---

**Figure 4.12 Coefficient Calculation**

![Coefficient Calculation](image_url)

Collected data for calibration
5 Sensor Replacement Board (SRB)

In addition to the Evaluation Kit, a sensor replacement board can be ordered. It allows the customer to do the first steps with the ZSSC30x6 without a final application sensor module. The sensor replacement board consists of two potentiometers between the positive and negative sensor line, which can be adjusted to represent the change in resistance of a sensor. One is for the coarse resistance regulation; the other for the fine adjustment. See Figure 5.1.

The SRB has an internal resistance of approximately 2kΩ. The specific resistance values between the single pins are given in Figure 5.2.

Figure 5.1 Sensor Replacement Board

Figure 5.2 Resistance Network of the SRB
6 Related Documents and Files

ZSSC30x6 Documents

<table>
<thead>
<tr>
<th>Document Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZSSC3016 Data Sheet</td>
<td></td>
</tr>
<tr>
<td>ZSSC3016 Feature Sheet</td>
<td></td>
</tr>
<tr>
<td>ZSSC3026 Data Sheet</td>
<td></td>
</tr>
<tr>
<td>ZSSC3026 Feature Sheet</td>
<td></td>
</tr>
<tr>
<td>ZSSC3036 Data Sheet</td>
<td></td>
</tr>
<tr>
<td>ZSSC3036 Feature Sheet</td>
<td></td>
</tr>
<tr>
<td>ZSSC30x6 Application Note – Application Circuits</td>
<td></td>
</tr>
<tr>
<td>ZSSC30x6 Application Note – Calibration Sequence and DLL</td>
<td></td>
</tr>
</tbody>
</table>

Visit the following ZSSC30x6 product pages on IDT’s website [www.IDT.com](http://www.IDT.com) or contact your nearest sales office for the latest version of these documents:

- [www.IDT.com/ZSSC3016](http://www.IDT.com/ZSSC3016)
- [www.IDT.com/ZSSC3026](http://www.IDT.com/ZSSC3026)
- [www.IDT.com/ZSSC3036](http://www.IDT.com/ZSSC3036)

7 Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A2D</td>
<td>Analog-to-digital</td>
</tr>
<tr>
<td>ACK</td>
<td>Acknowledge (interface’s protocol indicator for successful data/command transfer)</td>
</tr>
<tr>
<td>ADC</td>
<td>Analog-to-Digital Converter or Conversion</td>
</tr>
<tr>
<td>AZ</td>
<td>Auto-Zero (unspecific)</td>
</tr>
<tr>
<td>AZS</td>
<td>Auto-Zero Measurement for Sensor Bridge Path</td>
</tr>
<tr>
<td>AZT</td>
<td>Auto-Zero Measurement for Temperature Path</td>
</tr>
<tr>
<td>CDIP</td>
<td>Ceramic Dual-Inline Package</td>
</tr>
<tr>
<td>CLK</td>
<td>Clock</td>
</tr>
<tr>
<td>DF</td>
<td>Data Fetch (this is a command type)</td>
</tr>
<tr>
<td>DLL</td>
<td>Dynamic-Link Library</td>
</tr>
<tr>
<td>DUT</td>
<td>Device Under Test</td>
</tr>
<tr>
<td>DSP</td>
<td>Digital Signal Processor (digital configuration, calibration, calculation, communication unit)</td>
</tr>
<tr>
<td>FSO</td>
<td>Full Scale Output (value in percent relative to the ADC maximum output code; resolution dependent)</td>
</tr>
<tr>
<td>LSB</td>
<td>Least Significant Bit (“fine” portion of the converted signal)</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MSB</td>
<td>Most Significant Bit (&quot;coarse&quot; portion of the converted signal)</td>
</tr>
<tr>
<td>MTP</td>
<td>Multiple Time Programmable</td>
</tr>
<tr>
<td>NACK</td>
<td>Not Acknowledge (interface's protocol indicator for unsuccessful data/command transfer)</td>
</tr>
<tr>
<td>PCB</td>
<td>Printed Circuit Board</td>
</tr>
<tr>
<td>POR</td>
<td>Power-On-Reset</td>
</tr>
<tr>
<td>PQFN</td>
<td>Power Quad Flat No Leads</td>
</tr>
<tr>
<td>SM</td>
<td>Signal Measurement</td>
</tr>
<tr>
<td>SOT</td>
<td>Second-Order Term</td>
</tr>
<tr>
<td>SRB</td>
<td>Sensor Replacement Board</td>
</tr>
<tr>
<td>TM</td>
<td>Temperature Measurement</td>
</tr>
</tbody>
</table>

### 8 Document Revision History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>January 18, 2014</td>
<td>First release</td>
</tr>
<tr>
<td></td>
<td>April 1, 2016</td>
<td>Changed to IDT branding.</td>
</tr>
</tbody>
</table>
Appendix A: Schematics Communication Board
**Notice**

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.

5. Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality". The intended applications for each Renesas Electronics product depends on the product's quality grade, as indicated below.
   - "Standard": Computers, office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
   - "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

   Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.

6. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, "General Notes for Handling and Using Semiconductor Devices" in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such specified ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are responsible for evaluating the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations administered by the governments of any countries asserting jurisdiction over the parties or transactions.

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled subsidiaries.

(Note2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

(Rev.4.0-1 November 2017)

---

**Corporate Headquarters**

TOYOSU FORESIA, 3-24 Toyo-su,
Koto-ku, Tokyo 135-0061, Japan

[www.renesas.com](http://www.renesas.com)

---

**Contact Information**

For further information on a product, technology, the most up-to-date version of a document, or your nearest sales office, please visit:

[www.renesas.com/contact/](http://www.renesas.com/contact/)

---

**Trademarks**

Renesas and the Renesas logo are trademarks of Renesas Electronics Corporation. All trademarks and registered trademarks are the property of their respective owners.

---

© 2020 Renesas Electronics Corporation. All rights reserved.